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DynaComm/Elite

Introduction

Welcome to DynaComm/Elite, an advanced product for communicating
between your PC and an IBM mainframe environment. DynaComm/Elite
combines flexibility, functionality, and a friendly graphical interface to
assist with your mainframe work. DynaComm/Elite allows you to com-
municate with other applications on your PC (through DDE) or
applications on the mainframe (through DynaComm/Elite’s script language
or through APPC).

DynaComm/Elite’s functionality extends from its comprehensive script
language to its support for a wide variety of links, access of up to five
terminal sessions at time, file transfer and paste link capability, and a
built-in text editor. Since DynaComm/Elite is an application created for
Windows, you get the advantages of Windows, including a common
interface (menu bars and dialog boxes) and multitasking (use of other
applications as DynaComm/Elite communicates with a remote system).

The DynaCommy/Elite script language allows you to automate interactions
with Windows and host applications and to change the appearance of
DynaComm/Elite itself. This sophisticated script language provides all the
tools you need to create full-scale, communications applications.

DynaComm/Elite is easy to use and has an underlying structure which
allows you to simplify your communications tasks. The following section
contains a list of the features of DynaCommy/Elite. For more details about
the features, see the online help system.
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Features of DynaComm/Elite

3270 emulation, supporting up to five 3270 sessions. Terminal (screen)
sessions offer 3278/9 Display Station (Models 2-5) LU type 2 support.
Printer sessions offer IBM 3286/7 support, both LU type 3 Data Stream
Compatible (DSC) and LU type 1 SNA Character String (SCS) printers.

Full support of the file transfer program INDS$FILE under TSO, CMS, and
CICS. Host File List feature simplifies choosing and specifying file names.

IBM Office Vision (OV/MVS) document import and export support using
SNA Document Interchange Architecture (DIA) for the Revisable Form
Text (RFT) file format.

Paste Link providing a live exchange of data between a terminal session
and a Windows application which supports links between applications.
As the remote system changes the information in the terminal window,
the information you have pasted in another application changes.

Full color and extended attribute support. Full color remapping of all
terminal colors and attributes through an interactive graphical editor and
through script.

Optional graphics with Graphical Data Display Manager (GDDM)
support. Emulations include IBM 3179-G, 3472-G, and 3279-S3G, with
vector graphics and programmed symbol sets. Requires the Graphics
Option for Windows, sold separately by NetSoft.

Response Time Monitor (RTM) functions to aid NetView operators.

3270 and APPC, supporting concurrent 3270 and APPC sessions
through a single SNA physical unit (PU).

Support for a wide variety of connections: DFT/Coax, SDLC, 802.2 LLC,
AdaptSNA LAN Gateway via IPX/SPX, TCP/IP or NetBIOS, AdaptAsync
Controller or AdaptX25 Controller via asynchronous dial-up, Eicon
Gateway, DCA/Microsoft CommServer, and Novell Gateway (both
NetWare SNA Gateway and NetWare for SAA Gateway).

Full keyboard remapping through an interactive graphical editor and
remapper.

Flash Pad, a movable and sizable on-screen keypad, which can send
keystrokes and execute scripts with the click of a mouse. Includes the
Flash Pad Editor to visually create a flash pad to suit your needs.

Single user, shared access, or network installation.
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o A full featured, built-in text editor.

 Context sensitive help providing a Help button in every dialog, help for
menus (highlight a menu and press F1), and the standard Help menu.

e Multichannel Dynamic Data Exchange (DDE) which allows
DynaComm/Elite to be both server and client simultaneously.

e Built-in EHLLAPI interface, which supports the execution of DOS and
Windows EHLLAPI applications.

¢ Script Key Recorder with support for multiple sessions.

* A comprehensive script language that allows you to add custom
functionality (Dynamic Link Library, or DLL, support). It contains over
200 commands and functions with support for real numbers and floating
point math, parameter passing, event handling, variables, and indirect
variable referencing. Script commands allow you to define and
dynamically update custom menus and dialog boxes.

e The capability to perform file transfers in the background, which allows
you to run other applications during the transfer process.

Graphics Option (GDDM)

DynaComm/Elite: Graphics Option for Windows offers support for the
complete IBM 3270 graphics data stream as required for GDDM
(Graphical Data Display Manager) and includes APA graphics, vector
fonts, text and graphics cursors, and programmable symbol sets. This
capability allows DynaComm/Elite to fully emulate the IBM 3179-G,
3279-S3G, and 3472-G terminals as model types 2 and 3. Graphic images
can be copied to the Windows clipboard, printed, or saved to a file as a
Windows metafile or bitmap.

DynaComm/Elite: Graphics Option for Windows is available separately.
For more information about the GDDM module, call NetSoft at (714)
768-4013 and ask about DynaComm/Elite: Graphics Option for Windows.
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Customer Support

Online Help

DynaComm/Elite includes context-sensitive help. To access it, just press
F1, or select the Help button in any dialog box. The help system contains
information on all of the options in DynaComm/Elite as well as all the
commands and functions in the script language.

Technical Support

Registered users of DynaComm/Elite may call the NetSoft Technical
Support department. Telephone support is available on weekdays, 7 a.m.
to 5 p.m. Pacific time. Before contacting Technical Support, please gather
the details about your question. If you are having a problem with
DynaComm/Elite, this information should include your hardware and
software configurations, the DynaCommy/Elite version number (found in the
About option located on the Help menu), any other software loaded
(including TSRs) when you experienced the problem, and the exact
sequence of steps that precede the problem.

Phone Number Fax Number

(714) 766-4013 (714) 768-5049

NetSoft also operates bulletin board systems (BBSs). The BBSs can accept
modem speeds up to 14,400 bps. When sending files (traces, emulator
dumps, etc.) to NetSoft, please send them to the appropriate BBS.

BBS Numbers

(714) 768-1436 (1200 or 2400 only)
(714) 768-0926 (V.32 bis, V.42 bis)
(714) 768-5836 (V.32 bis, V.42 bis)
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Installation

Prior to Installation

Before installing DynaComm/Elite, you should have a basic understanding
of your computer in general and Windows in particular. You should know
how to operate Windows menus and dialog boxes, and how to select files
stored in directories on your hard drive. For information about the
Windows operating system, refer to your Microsoft Windows User’s Guide.

The DynaCommy/Elite installation disks are not copy protected. Make a
working copy of each disk and use the working copies to perform the
installation. Store the original diskettes in a safe location. By taking this
precaution, if you ever want to reinstall DynaComm/Elite, you have a
backup copy available even if your working copy becomes damaged. You
are licensed to make up to three copies of the DynaComm/Elite software as
backups.

Installation Options

You can install DynaComm/Elite in one of three ways, depending on the
license agreement for the version of DynaComm/Elite that you purchased.

e Single User Installation. You may install the full version
DynaComm/Elite onto a personal computer. Depending on your license,
authorized users may install DynaCommy/Elite onto a personal computer
from the installation disks provided with the product or from a network
directory.

e Shared Access Installation. The network administrator installs
DynaComm/Elite on a shared network directory, where an authorized
person is allowed to access DynaComm/Elite and install files that are
specific to the installation chosen. This type of installation requires less
hard drive space on the local personal computer, since most of
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DynaComm/Elite’s files are stored on the network directory and shared
among the persons authorized to access the DynaComm/Elite files.

o Network Installation. The network administrator installs all of
DynaComm/Elite’s files into a shared network directory. An authorized
person can then install DynaComm/Elite on a personal computer from
the network directory instead of the installation disks shipped with the
product.

Installation Requirements on a PC

e An IBM PC, PS/2, or 100% compatible computer capable of running
Windows 3.1, or greater.

e Four megabytes of RAM.

e Approximately 8.5 megabytes of free space on your personal computers
hard drive in order to install the complete DynaComm/Elite
environment. You will need approximately 5.5 megabytes of space if
you wish to install only the DynaComm/Elite application and drivers.

If you are installing the files for a version of DynaCommy/Elite shared
from a network directory, you will need about 500 kilobytes on your
personal computers hard drive.

e Microsoft Windows must run in its Standard or 386 Enhanced mode.

e Installation of the software for the communications adapter that your
personal computer uses to connect to your host. DynaComm/Elite
requires specific versions of the software for some types of
communication links.

AdaptSNA LAN Gateway (IPX/SPX) and Novell Gateway

Required Versions: VIPX.386 (11/21/91, 1:40 p.m., or later)
IPX.COM (3.10, or greater)

AdaptSNA LAN Gateway (TCP/IP)

Required Versions: Sun Microsystems PC-NFS for DOS (4.0af4 or greater)
Novell’s LAN WorkPlace for DOS (4.01, or greater)
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Comm Server

Required Versions: Microsoft Lan Manager (2.0C, or greater)
Microsoft/DCA Comm Server (1.1, or greater)

See the online help for further information about configuring the

communications link. Particularly, you will need to look to the online help
for information about necessary modifications to some of your system files.

Installation

Single User Installation

DynaComm/Elite’s files are shipped in a compressed form; you must use
the Setup program to install them on your personal computer and to
properly create the directory structure and initialization files that
DynaComm/Elite expects. The following instructions assume you are using
a mouse with Windows. If your system is not equipped with a mouse, you
will need to substitute the keyboard equivalents for pointing and clicking.

1. Start Windows.

2. If you are installing from DynaCommy/Elite’s installation diskettes,
insert Installation Disk 1 into your floppy drive.

3. From the File menu of the Program Manager, choose the Run option.
For installation from a diskette, type the drive letter followed by a
colon and the characters setup.

For example:

a:setup
For installation from a network directory, include the path between the
colon and the characters setup.

For example:

n:\progs\de3270\setup
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4. The Setup program will suggest a directory to use for installing
DynaComm/Elite on your personal computer. To use this default
directory, click the OK button. To install DynaComm/Elite in a
different directory, type the new path name in the edit text box, then
click the OK button. If you specify a directory which does not exist,
the Setup program will create it for you.

You may halt the installation at any time by clicking the Cancel button.

Canceling the installation only halts the process; it does not delete any files or
directories which have already been copied or created.

5. The next dialog box will ask you to specify which additional files you
would like to install.

If you are installing DynaComm/Elite for the first time, we suggest that
you install all the additional files. If you already know which files you
need, or if your hard disk space is running low, you may choose not to
install some of the optional files. You can add them later by running
the Setup program again.

You can also allow the Setup program to create a DynaComm/Elite
group for the Program Manager. Once you have chosen your
installation options, click the OK button. The Setup program will
indicate the progress of the installation.

6. If you are installing from an installation diskette, the Setup program
will request an additional disk when it needs it. Remove the current
disk from the floppy drive, replace it with the requested disk, then
click the OK button.

7. After transferring the files to your hard drive, the Setup program will
add a DynaComm/Elite group to the Program Manager, if you selected
that option.

8. After the installation is complete, you may need to alter some of the
system files of your computer and create a DynaComm/Elite settings
file. These actions are necessary for DynaComm/Elite to communicate
with a remote system.

For more information on editing the system files, see the appropriate link
in the "Communications Configuration" section under the "Procedures"
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section in the online help. For more information on creating a settings file,
see the "Creating Settings Files" section under the "Procedures" section in
the online help.

Shared Access Installation

The shared access installation assumes that a network administrator has
previously installed DynaComm/Elite in a network directory in preparation
for shared access of DynaComm/Elite. For more information about
installing DynaComm/Elite in a network directory, network administrators
should refer to Chapter 4, "Administrator Information." As a shared access
user, you should do the following:

1.
2.

Start Windows.

From the File menu of the Program Manager, choose the Run option.
Type the network drive letter for the drive where the network
administrator installed DynaComm/Elite’s files, and then type a colon,
the path to the files, and the characters setupusr. For example:

n:\progs\de3270\setupusr

The Setup program will suggest a directory to use for installing
DynaCommy/Elite’s data files on your personal computer. To use this
default directory, click the OK button. To install the files in a different
directory, type the new path name in the edit text box, then click the
OK button. If you specify a directory which does not exist, the Setup
program will create it for you.

You may halt the installation at any time by clicking the Cancel button.

Canceling the installation only halts the process; it does not delete any files or
directories which have already been copied or created.

You can also allow the Setup program to create a DynaComm/Elite
group for the Program Manager. Once you have chosen your
installation options, click the OK button. The Setup program will
indicate the progress of the installation.
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5. After transferring the files to your hard drive, the Setup program will
add a DynaComm/Elite group to the Program Manager, if you selected
that option.

6. After the installation is complete, you may need to alter some system
files on your computer and create a DynaComm/Elite settings file.
These actions are necessary for DynaComm/Elite to communicate with
a remote system. Your network administrator may have made these
modifications for you, so consult with the administrator first.

For more information on editing the system files, please see the
appropriate link in the "Communications Configuration" section under the
"Procedures" section in the online help. For more information on creating a
settings file, please see the "Creating Settings Files" section under the
"Procedures" section in the online help.

Network Installation

For more information about installing DynaComm/Elite in a network
directory, refer to Chapter 4, "Administrator Information."

Communication Links

DynaComm/Elite provides separate, interchangeable physical link drivers.
The physical link is what physically connects your PC to the remote
system. The link driver controls the physical link and is responsible for
maintaining the connection and keeping the session alive. It also acts as a
translator between DynaComm/Elite and the link hardware, sending and
receiving SNA frames in the host data stream.

The supported links are:

e AdaptAsync Controller or AdaptX25 Controller via asynchronous dial-up
e AdaptSNA LAN Gateway via IPX/SPX, NetBIOS or TCP/IP

e DFT/Coax connection via a 3174/3274 Controller

e DCA/Microsoft Communications Server

¢ Microsoft SNA Server

o Eicon Gateway via NetBIOS or IPX/SPX
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e Novell Gateway (both NetWare SNA Gateway, version 1.3, or greater;
and NetWare for SAA Gateway)

e SDLC (direct connect or dial-up with synchronous modem)
e 802.2 via token ring or Ethernet.

For the configuration information about a particular link driver, and the
information for operating certain link specific software options (such as an
autodialer), see the appropriate section in the "Communications
Configuration" section under the "Procedures" section in the online help.
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Using DynaComm/Elite

Start-up

Since DynaComm/Elite is a Windows product, you must run it in
Windows. If you allowed the Setup program to create a program group
when you installed DynaComm/Elite, you can double-click on the
DynaComm/Elite icon in its program group.

B DynaCommjElite 3.5

ﬁ 3|
e

BIREININHANE  CluickStart  Assist for APPC

2

Read Me First!  Scrpt Manager  Dialog E ditor

If you don’t have DynaComm/Elite’s icon in some program group, you can
start DynaComm/Elite by opening the File Manager and double-clicking on
DE3270.EXE in the DynaComm/Elite directory (usually C:\DE3270). If you
prefer a command line, select the Run option in the File menu of either the
Program Manager or the File Manager and type the full path of the
DynaComm/Elite program

For example:

C:\DE3270\DE3270.EXE
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DynaComm/Elite Windows

When you first run DynaComm/Elite, you will initially see only the
application window. However, depending on how you configure
DynaComm/Elite, it could start up and automatically connect to a remote
system. The following is an illustration of the application window with
some child (or document) windows.

Application Control Menu

Child Window Control Menu

Child Window Title Bar Maximize Button
Tool Bar Application Title Bar Minimize Button
Menu Bar

|
| File Edit Settings Canne

Prrse
NetSoft L Laguna Hills, CA
Corporate Headguarters (714} 768-4013

Fill in your USERID and PASSWORD and press ENTER
(Your password will not appear when you type it}
USERID  ===>
PASSWORD ===>

COMMAND ~ ===>

A28 C16

e ORIy
Minimized Child Windows l— Status Bar
Operator Information Area

Terminal Window (Session Screen)

Besides the application window itself, there are specialized areas in the
window which can assist you during a terminal session or when you are
editing a script or text file.
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ToolBar

The toolbar is displayed across the top of the application window and
below the menu bar, to give quick mouse access to DynaComm/Elite’s
tools.

—— Open existing file

—— Save current settings
—— Color editor
— Cut selection to clipboard
— Initiate file transfer from PC to Host
—— Copy selection to clipboard
— Initiate file transfer from Host to PC
— Insert clipboard contents

View keyboard mapping ]

: -
1% (== ] |551E

Print active session window Start macro recorder

Connect configured sessions Start script recorder
Disconnect all connected sessions Stop script/macro recorder

Switch to next DynaComm/Elite window Help system
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Status Bar

The status bar displays information about DynaComm/Elite’s current state,
the state of the toggle keys (Caps Lock, Num Lock, and Scroll Lock) on
your keyboard, and other information. Also, when a session window is
active, the buttons on the bar will allow you to change the size of the
window. Depending on the font sizes that you select in the Window
Preferences dialog for the font in a session window, the size of font within
a session window will change as you change the size of the window.

Scroll Lock Indicator

Num Lock Indicator

Status Area Clock/Timer —‘

e

Ready ' . T iBm Caps | Nom

s

Cap Lock Indicator —

Insert Lock Indicator —

Zoom In —

Zoom Out —

Help

DynaComm/Elite provides you with a number of ways of getting help: the
Help menu and its options; Help buttons in each of the dialogs; and the F1
key.

The F1 key will apen the online help when you have selected or activated a menu,
menu option, dialog box, or memo or script window. However, if a session window is
in focus, the F1 key will function as the host session dictates (usually as a PF1 key).
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Exiting DynaComm/Elite

To exit DynaComm/Elite, select the Exit option in the File menu, the Close
option in the application Control menu, double-click the application
Control menu, or type Alt + F4.
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Administrator Information

Types of Installations

From a network point of view, you can install DynaComm/Elite in two
different ways, depending on your license for DynaComm/Elite and how
authorized persons access the product. In the first method, you install the
files in a network directory to allow authorized people to install a
complete copy of DynaComm/Elite for individual use. This installation is
similar to installing the product from the installation diskettes provided for
the product.

In the second method of installation, you install the files in a network
directory to allow authorized users to share most of DynaComm/Elite’s
files. After your installation, the users will then run an installation program
that installs only the data files (files with the extensions: CLM, DES, INI,
KBL, and KBM) in a personal directory and leaves the majority of
DynaComm/Elite’s files on the network .

Setup Options

Setup provides three options for installation:

e Single User Installation. An authorized person will use this option to
install DynaComm/Elite in a personal directory. The user would select
this option, whether installing from the installation diskettes provided
with the product or from a directory on the network. The user runs
SETUP.EXE to install DynaComm/Elite.

o Shared Access Installation. In this option, you have installed
DynaComm/Elite in a shared network directory, where authorized users
can install the data files of DynaComm/Elite and run the program from
the network. The user runs SETUPUSR.EXE to install the data files in a
personal directory.
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Network Installation. With this option, you install DynaComm/Elite’s
files into a network installation directory. An authorized user can then
create an installation of DynaComm/Elite in a personal directory from
the network installation directory instead of the installation disks
shipped with the product.

Changes on the PC

Installation Changes

When a user installs DynaComm/Elite into a personal directory, the
installation program will also make additions and changes to some of the
system directories of the computer.

DYNACOMM.INI. The initialization file for DynaComm/Elite is added
to the Windows directory. This file holds default communications
settings for DynaComm/Elite and other initialization data.

DIALOGED.INI. The initialization file for DynaComm/Elite’s dialog
editor (DIALOGED.EXE) is added to the Windows directory. This file
holds default settings for the editor.

SYSTEM.INI. The installation program may add entries to the
SYSTEM.INI in the [386Enh] section. Depending on the connector, the
installation program may add device entries for the virtual device drivers
VNS8022M.386 and VNSAINTD.386

Fonts. The installation program copies DynaComm/Elite’s font files to
the installation directory and then makes Windows aware of the fonts.

NetWare Files. DynaComm/Elite will copy the following files to the
Windows directory: NWCALLS.DLL, NWIPXSPX.DLL, TLI_SPX.DLL,
TLI_TCP.DLL, and TLI_WIN.DLL. The installation program copies these
files when the user selects the Novell or AdaptSNA LAN Gateways.

If these files alreadly exist in the Windows directory and if they have a date that is older
than the files that the installation program would install, the installation program will
overwrite the existing files.
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Changes After Installation

Some communications links require additional changes after the
installation program has ended. These changes can include edits to the
AUTOEXEC.BAT and SYSTEM.INI files, for example, and are dependent on
the connectors that DynaComm/Elite accesses. These changes are
described in the "Communication Configuration" section of the online help.

Network Administration

As a network administrator, you sometimes need to control how others
install DynaComm/Elite. For example, the users may not need all of the
keyboard mapping files, or you may wish to distribute pre-configured
communications settings. Changing the contents of SETUP.INF allows you
to change the installation.

Editing the SETUP.INF File

Make a backup copy of the INF file before you edit it. It is a plain text file.
You customize an installation by adding and removing entries from the
file. The structure of an INF file is similar to any Windows initialization file
(IN1). If you deviate from that structure, the installation that you planned
may fail.

Do not modify the first two sections of the INF file, the sections titled [Source Media
Descriptions] and [Default File Settings].

Removing Entries

You may want to remove some INF file entries that install files which are
superfluous to your particular needs. To remove an entry on a line, place a
semicolon in the first column of a line. The semicolon makes the entry a
comment, which the installation program ignores. By inserting a semicolon
rather than actually deleting the entry, you can easily revert to the original
entry if you need to.
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Adding Entries

You can customize the installation further by adding entries to the INF file.
For example, you may want to provide the users with settings files,
keyboard map files, and scripts that are specific to their requirements. To
add an entry, select the appropriate section. To make a new entry easy to
locate, place it at the bottom of a section and add a blank line between the
default entries and your new entry.

When you add an entry, you must make sure that its format is like the
format of the entries in the rest of that section. The format may vary
depending on the section, but usually the fields of the entry must be
delimited by commas, and the entry must end with a comma. You may
find it easiest to add an entry by copying an existing entry in a section and
then replacing the fields of the entry with the appropriate new information.

The following is the format for sections where files are listed (such as [HLP]
and [CFGDLL]):

<Tab>DiskNumber,Name,,,,h Date,,,,ReadFlag,,.,.. UncommpressedSize,,

The entry begins with a tab, contains 19 comma separated fields, and ends
with a comma (for a total of 20 commas in a line). The first field is
DiskNumber and is the number of the disk where the file is located (if the
directory is a network directory this number is always one). The second
field is Name and is the path name of the file on the source disk. The sixth
field is Date and is the date of the file in the following format: yyyy-mm-dd
(a four-digit year, two-digit month, and two-digit day separated by
hyphens). The tenth field is ReadFlag and determines the status of the file
when copied to its destination. The sixteenth field is UncompressedSize
and is the uncompressed size of the file in bytes.

Example:
1,DE3270.EXE,,,,1995-07-04,,,, !READONLY,,,,,,425424,,,,,

A tab precedes the first field. The number 1 indicates the source disk from
where the installation program installs the file (this example assumes a
network installation). DE3270.EXE is the name of the file to install. The
number 1995-07-04 is the date of the file on the source disk. The
installation program uses the flag /READONLY to make sure files are
readable and writable in the installation directory. The number 425424
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indicates how many bytes that the file will need for storage on the
destination disk.

Alternate INF Files

Depending on the needs of the users you may need to create a number of
SETUP.INF files, each for a different group of users. The person running the
installation program can use another INF file by specifying the full path to
the INF file:

Setup /1DriveName:\FullPath\AnotherFile.INF

The drive and full path name are required. Also, the //switch is required, and no space
should separate the switch from the drive letter. For instance, if the drive letter is A,
the command line might look like the following:

SETUP /IN:\PROGS\SETUPZ2.INF

Previous Installations

DynaComm/Elite easily installs over a previous installation. If the
installation program detects a previous installation on your system, the
program will inform you and set the directory to the existing directory. If
you let the installation program install in the existing directory, it will
replace the old files with the new ones.

To keep the previous installation, enter another location for the new
installation of DynaComm/Elite. If you want to run the previous version,
you will need to save the present DYNACOMM.INI (located in the
Windows directory) under another name, because the installation program
will change DYNACOMM.INI to point to the new installation. The
installation program will also change the properties of the icons in the
DynaComm/Elite group (located in the Program Manager) to point to the
new installation.
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If you want to keep the old program group change its name in the Program
Manager. Select the old DynaComm/Elite program group, select the
Properties option in the Program Managers File menu, change the text in
the Description edit text box to some name other than DynaComm/Elite,
and click on the Ok button. Then install the new version of
DynaComm/Elite.

DynaCommyElite does not support multiple instances of itself running from the same
installation and does not support more than one functioning version (or installation)
of itself at the same time.

Un-installing DynaComm/Elite

Exit Windows.

2. Delete the directory where you installed the DynaComm/Elite files (the
default is DE3270).

3. Delete the files listed in the previous "NetWare Files" section, unless
you use the files for connecting to a Novell gateway.

4. Delete the entire [VNS8022M.386] section and the VNS8022M.386
and VNSAINTD.386 entries in SYSTEM.INI.

5. Delete the DynaComm/Elite program group in the Program Manager if
you allowed the installation program to create the program group
during installation.

6. Delete both DYNACOMM.INI and DIALOGED.INI in your Windows
directory.

Installing Files

The list of the files that make up DynaComm/Elite are listed and described
in filelist.dcm. This file is placed on your first installation disk or in
DynaComm/Elite’s System directory (the default is DE3270). The
descriptions of the files contained in FileList can help the network
administrator decide which files to install.
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DynaComm/Elite contains and produces files with a variety of purposes
and file extensions. The following is a listing of the default directory names
and names of the files placed in the directories.

DE3270 (Main, or System directory). BMP (bitmaps), CLM (color maps),
DLL (Dynamic Link Libraries), EXE (executables), FON (fonts), FPD (flash
pads), HLP (helps), KBL (PC keyboard layouts), KBM (keyboard maps),
and KBT (3270 keyboard layouts) files.

DAT (Data and Download Directory). Data files and files with other
extensions.

DCI (Icon Directory). ICO (icons) files.

DCM (Memo Directory). Most DCM (plain text) files, including the
readmes GRAPHICS.DCM and README.DCM.

DCP (Script Directory). Most DCP (text, or script source) files. Most
DCT (compiled, or script task) files. FSEICONS.DCM file for the
SHOWICON script.

DES (Settings Directory). DES (settings) files.

DMP (Dump Directory) DMP (binary) files generated with the Status
Dump option in the File menu.

DTR (Trace Directory). DCM (text) files generated with the Trace Start,
HLLAPI Trace Start, and APPC Trace Start options in the File menu.
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